JENSEN’

PORTABLE 3-SPEED TURNTABLE WITH
BUILT-IN SPEAKERS

USER MANUAL
JTA-410

PLEASE READ THIS USER MANUAL COMPLETELY BEFORE OPERATING THIS UNIT
AND RETAIN THIS BOOKLET FOR FUTURE REFERENCE.




TO PREVENT FIRE OR SHOCK HAZARD, DO NOT USE THIS PLUG WITH AN EXTENSION
CORD, RECEPTACLE OR OTHER OUTLET UNLESS THE BLADES CAN BE FULLY
INSERTED TO PREVENT BLADE EXPOSURE. TO PREVENT FIRE OR SHOCK HAZARD, DO

NOT EXPOSE THIS APPLIANCE TO RAIN OR MOISTURE.

The lightning flash with arrowhead
symbol, within an equilateral
triangel is intended to alert the user
to the presence of uninsulated

CAUTION

RISK OF ELECTRIC SHOCK

DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF
ELECTRIC SHOCK, DO NOT REMOVE
COVER (OR BACK). NO USER - SERVICE-
ABLE PARTS INSIDE. REFERSERVICING TO

The exclamation point within an
equilateral triangel is intended to
alert the user to the presence of
important operating and mainte-

dangerous voltage within the
product is enclosure that may be of
sufficient magnitude to constitute a
risk of electric shock to persons.

QUALIFIED SERVICE PERSONEL. nance (servicing) instructions in the
literature accomoanying the

appliance.

The Caution Marking is located at the back enclosure of the apparatus.
The Rating plate is located at the back enclosure of the apparatus

IMPORTANT SAFETY INSTRUCTIONS

Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this apparatus near water.
Clean only with dry cloth.

Do not block any ventilation openings. Install in accordance with the manufacturer’s
instructions.

Do not install near any heat sources such as radiators, heat registers, stoves, or
other apparatus (including amplifiers) that product heat.

Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized
plug has two blades with one wider than the other. A grounding type plug has two
blades and a third grounding prong. The wide blade or the third prong is provided for
your safety. If the provided plug does not fit into your outlet, consult an electrician for
replacement of the obsolete outlet.

Protect the power cord from being walked on or pinched particularly at plugs,
convenience receptacles, and the point where they exit from the apparatus.

Only use attachments/accessories specified by the manufacturer.

Use only with a cart, stand, tripod, bracket, or table
recommended by the manufacturer, or sold with the product.
When a cart is used, use caution when moving the
cart/apparatus combination to avoid injury from tip-over.
Unplug this apparatus during lightning storms or when
unused for a long periods of time.
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10.

1.
12.

13.

14. Refer all servicing to qualified service personnel. Servicing is required when the

apparatus has been damaged in any way, such as power-supply cord or plug is
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15.
16.
17.
18.

19.

20.

21.

geos

damaged, liquid has been spilled or objects have fallen into the apparatus, the
apparatus has been exposed to rain or moisture, does not operate normally, or has
been dropped.

This appliance shall not be exposed to dripping or splashing water and that no object
filled with liquids such as vases shall be placed on the apparatus.

Do not overload wall outlet. Use only power source as indicated.

Use replacement part as specified by the manufacturer.

Upon completion of any service or repairs to this product, ask the service technician
to perform safety checks.

Power Sources - This product should be operated only from the type of power source
indicated on the marking label. If you are not sure of the type of power supply to your
home, consult your product dealer or local power company. For products intended to
operate from battery power, or other sources, refer to the operating instruction.
Object and Liquid Entry - Never push objects of any kind into this product through
openings as they may touch dangerous voltage points or short-out parts that could
result in a fire or electric shock. Never spill liquid of any kind on the product.

Damage Requiring Service - Unplug this product from the wall outlet and refer
servicing to qualified service personnel under the following conditions:

When the power-supply cord or plug is damaged,

If liquid has been spilled, or objects have fallen into the product,

If the product has been exposed to rain or water,

If the product does not operate normally by following the operating instructions.
Adjust only those controls that are covered by the operating instructions as an
improper adjustment of other controls may result in damage and will often require
extensive work by a qualified technician to restore the product to its normal
operation.

e) If the product has been dropped or damaged in any way, and

—+
S

22.

23.
24.

This symbol indicates that this product incorporates double insulation
between hazardous mains voltage and user accessible parts.

CAUTION:
TO PREVENT ELECTRIC SHOCK, MATCH WIDE
BLADE OF AC PLUG TO WIDE SLOT. FULLY INSERT.

When the product exhibits a distinct change in performance - this indicates a need
for service.
Main plug is used as disconnect device and it should remain readily operable during
intended use. In order to disconnect the apparatus from the mains completely, the
mains plug should be disconnected from the mains socket outlet completely.
Battery shall not be exposed to excessive heat such as sunshine, fire or the like.
Excessive sound pressure from earphones and headphone can cause hearing loss.

SAVE THESE INSTRUCTIONS
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COMPLIANCE WITH FCC REGULATIONS

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions:
(1) this device may not cause harmful interference, and
(2) this device must accept any interference received, including interference that may
cause undesired operation.
NOTE : This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference will not occur in
a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

CAUTION: Changes or modifications not expressly approved by the party
responsible for compliance could void the user’s authority to operate
the equipment.

PROTECT YOUR FURNITURE

This model is equipped with non-skid rubber 'feet' to prevent the product from moving
when you put the JTA-410 on your furniture. These 'feet' are made from non-migrating
rubber material specially formulated to avoid leaving any marks or stains on your
furniture. However certain types of oil based furniture polishes, wood preservatives, or
cleaning sprays may cause the rubber 'feet' to soften, and leave marks or a rubber
residue on the furniture. To prevent any damage to your furniture we strongly
recommend that you purchase small self-adhesive felt pads, available at hardware
stores and home improvement centers everywhere, and apply these pads to the bottom
of the rubber 'feet' before you place the product on fine wooden furniture.

To avoid scratch your table/furniture, product packed four rubber feet together with I/M,
place those four rubber feet on the table and locate the product on those feet as below.

‘ F@@)@A

Feet
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DEAR JENSEN® CUSTOMER

Selecting fine audio equipment such as the unit you've just purchased is only the start
of your musical enjoyment. Now it's time to consider how you can maximize the fun
and excitement your equipment offers. This manufacturer and the Electronic Industries
Association's Consumer Electronics Group want you to get the most out of your
equipment by playing it at a safe level. One that lets the sound come through loud and
clear without annoying blaring or distortion and, most importantly, without affecting
your sensitive hearing.

Sound can be deceiving. Over time your hearing "comfort level" adapts to higher
volumes of sound. So what sounds "normal" can actually be loud and harmful to your
hearing. Guard against this by setting your equipment at a safe level BEFORE your
hearing adapts.

To establish a safe level:

e Start your volume control at a low setting.

e Slowly increase the sound until you can hear it comfortably and clearly, and without
distortion.

¢ Once you have established a comfortable sound level: Set the dial and leave it
there.

Taking a minute to do this now will help to prevent hearing damage or loss in the future.
After all, we want you listening for a lifetime.

We Want You Listening For a Lifetime

Used wisely, your new sound equipment will provide a
lifetime of fun and enjoyment. Since hearing damage from
loud noise is often undetectable until it is too late, this
manufacturer and the Electronic Industries Association's
Consumer Electronics Group recommend you avoid
prolonged exposure to excessive noise.

Customer's Record:

The serial number of this product is found on its back cover. You should note the serial
number of this unit in the space provided as a permanent record of your purchase to
aid in identification in the event of theft of loss.

Model Number: JTA-410 Serial Number:




ACCESSORIES INCLUDED

- Power Cord

- Application CD
- USB cable

- User Manual

LOCATION OF CONTROLS

SPEAKERS

6
I
|
|

45 ADAPTER

W=

O=——-2 TURNTABLE

___ | SPEED SELECTOR
, E— = @ 3 4 | TONE ARM
: ° STYLUS

ol — 2 5 | POWER ON/OFF,
VOLUME KNOB

6 | ANTI-SHOCK LOCK
DOWN SCREW

7 | LINE OUT RCA
b o e JACKS

8 | AUX IN JACK

9 | USB PORT

Do | -  TT777" 10| AC SOCKET

11 | BATTERY DOOR

POWER SOURCE

The JTA-410 operates using standard 120V~ 60Hz AC household power or 8 x “C” size
(UM-2) batteries (Not included).

A. BATTERY OPERATION
For best performance and longer operating time, we recommend the use of alkaline
batteries.

1. Remove the Battery Door (#11). o e | |- e—0s
2. Following the polarity (+ and -) diagram as — 2 ] -
shown inside the battery compartment, insert 8 |E g

‘C’ size (UM-2) batteries. - O
3. Replace the Battery Door (#11). = 2
le__ecile___ejale__ejals en

BATTERY WARNING

1. Be sure that the batteries are installed correctly. Wrong polarity may damage the unit.

2. (a) Do not mix old and new batteries.
(b) Do not mix alkaline, standard (carbon-zinc) or rechargeable (nickel-cadmium)
batteries.

3. If the unit is not to be used for an extended period of time, remove the batteries. Old
or leaking batteries can cause damage to the unit and may void the warranty.
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4. Do not dispose of batteries in fire, batteries may explode or leak.
5. Do not try to recharge batteries not intended to be recharged; they can overheat
and rupture.( Follow battery manufacturer’s directions ).

B. AC POWER CONNECTION

1. Insert one end of power cord to the AC Socket (#10) at the back of the JTA-410.

2. Connect the power cord to AC power source.

3. When the unit is operated from AC power source, the internal battery source will
automatically be disconnected.

ANTI-SHOCK LOCK DOWN SCREW

The turntable on this unit features a built in Anti-Shock system, and the turntable is
locked down when shipped from the factory. Turn the anti-shock lock down screw (#6), in
a clockwise direction to release the turntable and activate the anti-shock feature before
using the turntable.

STEREO PHONOGRAPH OPERATION
Please Note - Before Use

- Remove the stylus protector.
- Make sure that the tone arm is unlocked and free .
Cartridge  —,
L4

to move from the tone arm rest prior to operating.
Lock the tone arm in place again when not in use.

Stylus assembly —» &2
Raise the JTA-410 top cover.

Turn on the system by rotating the Power on/off/volume knob (#5) clockwise until the
“Power LED” turns on.

3. Place a record on the turntable platter [ use the 45 RPM SPINDLE ADAPTOR (#2) if
you are playing 45 RPM records ].

4. Setthe TURNTABLE SPEED SELECTOR (#3) to the proper position for the record

you are playing.

5. Lift the tone arm from the rest and slowly move it over the
record. The turntable platter will begin spinning.

6. Place the tone arm down onto the record at the location that

you want to play.

Adjust the volume to the desired level. 4

At the end of record, the platter will stop spinning and the

tone arm will return to the rest automatically.
9. To stop playing, manually lift the tone arm from the record and return it to the rest.

NN —

© ~

NOTES:

Make sure the cover latch is in lock position when the cover is open.

Don’t close the cover while playing a record.

Do not leave a record on the turntable when closing the cover.

The turntable will automatically disconnect and stop playing when a 3.5mm stereo
aux-in cord (not included) is plugged into the AUX IN JACK (#8) on the back.

oo~
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AUX IN OPERATION

You can play other music sources (iPod, MP3 or other digital audio players) through the
speakers of the JTA-410 by connecting the AUX IN JACK (#8) to your external player’s
audio out jack or headphone jack.

1. Use an audio cable (not included) with one 3.5 mm stereo plug on each end of the
cable.

2. Plug one end into the AUX IN JACK (#8) on the JTA-410 and the other end of the

cable into the Line-out Jack or Headphone Jack of your external audio device. It will

automatically switch the unit to AUX mode.

Turn on the JTA-410.

Start playing the device you plugged into the AUX IN JACK (#8).

Slowly adjust both the volume controls of the JTA-410 and the external device until

you reach a comfortable listening level.

Note:

(1). If the line out jack of your external device is connected, then you only need to adjust
the volume control of this system. If the Headphone Jack of your external device is
connected, then you may need to adjust both the volume control of your external
device and the volume control of this system to find the most desirable volume
setting.

(2). Once the AUX IN JACK (#8) is plugged, the unit will enter the AUX mode.
Remember to disconnect the connection cable from the JTA-410 after use in order to
be able to listen to the record from the Turntable.

(3). Rotate the POWER ON/OFF/VOLUME KNOBS to turn off the JTA-410 when you
finish listening. Don't forget to switch off the power on your external device as well.

LINE OUT CONNECTION

You can connect the JTA-410 to an external Hi-Fi / AMPLIFIER system by connecting
the LINE-OUT RCA JACKS (#7) to the auxiliary input jacks on your Hi-Fi / Amplifier
system with RCA cables (not included).

Note: The Volume control on the JTA-410 will not adjust the volume when using the
LINE-OUT jacks.

ok

CONNECTING TO A COMPUTER FOR RECORDING

Before getting start, please install the “AUDACITY ” recording software onto your
computer. Below is an example using a computer with Microsoft XP and the Audacity
software installed. For other Windows OS or Mac OS, please visit Audacity website for
details. http://audacity.sourceforge.net/

INSTALLING THE AUDACITY SOFTWARE
1. Insert the Audacity disc (included) into the CD drive of your computer.
2. Click on My computer on the desktop.
3. Double click CD drive to view the contents of the CD and select “Windows” under
4
5

“Audacity” folder.
. Open “Windows” folder and select “Audacity 2.0.3(Windows 2000, XP, Vista, 7, 8)”.
. Double click Audacity set up icon with file name “audacity-win-2.0.3” to install the
Audacity software according to the instruction, read license agreements of Audacity
before installation.
NOTE:
Free software (AUDACITY) licensed under the GNU general public license (GPL).
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More information as well as open source code can be found on the provided CD or on
the website at: http://audacity.sourceforge.net/

INSTALL THE USB DRIVE

1.
2.

Use the included USB cable to connect the turntable to your computer.

Your computer will detect the JTA-410 as a “USB PnP Audio Device” & start to install
USB drivers for it automatically.

Waiting for the installation complete until your computer shows a pop up a message
that it is installed properly and ready to use.

SET RECORDING INPUT LEVEL (USING A WINDOWS XP COMPUTER)

1.
2.

3.

Click the “Start” in the left corner of your computer
Select “All Programs® =» “Accessories” = “Entertainment“=2 “Sound Recorder” to
open the sound record interface.

—— -

HT] New Office Dacument 3 _..__~

& open Office Dacument s“-

@ Set Program Access and Defaults

A% Windows Catalog
B windows Update

@ . -
»
(@ Adobe Livecycls E52 3
[ Chinese Inpuk Utiity (For the 150 10646 Standard)  »
| @) <-Media 30 Audio 3 e Control

[ EPSON Printers vl ") Address Book () Windows Media Player
(@) Fedex Ship Manager Softwars vl 2 caleuator h
[ Filezila FTP Client vl B command Prompt
@ sames vl @ notepad - -
) 100 Groupware Client vl Y Paint .
@ iTunes H| @) Program Compatibiity Wizard
[ K-Lite Coder Pack + || % Remote Deskkop Connection —
[ KONICA MINOLTA | 58 Seanner and Camera Wizard

(@) Microsoft Office Todls | €& synchronize

sl @ nera @ Tour windows 2P

s [ QuickTime v\l £ windows Explorer

Administrator | [EESCYET H | windows Mavie Maker
@ startup vl (A wordrad

ﬁ]ntemet [ Svmantec Endpoint Protection »

Inkernet Explorer Adobe Acrobat: Distiller %
@ E-mail irdobe Acrobat % Pro
Outlaok Express ) Guty

@Wmdnws Pedia Play & tenet Exporer
Microsoft Access

@ Tour indows P Microsoft Excel

— Microsoft Qutlock

Select “Edit” and then click “Audio Properties” towards the bottom of the menu to
select “Audio properties” interface.

‘% Sound - Sound Recorder E]

‘% Sound - Sound Recorder

File N Effects Help Effects Help
= Copy Chrl+C
ol Length: Paste I k Chrl+Y
0.00 zec. 0.00 zec. ] aske |‘fser r
: Paste Mix
- Insert File, ..

Mlize with File. ..

> | > | =

Delete Before Current Position
Delete After Current Position

fudio Properties




4. In the Sound Recording field, click the pull down menu to select “USB PnP Audio
Device” as Default device of sound recording.

Audio Properties

Audio Devices |

Sound playback

@J Default device:
2/

iE-Media Wave Device v|

Wolume... ] [ Advanced... ]

Sound recording

/@ Default device:
| USB PnP Audio Device v|

USB PnP Audio Device
C-Media Wave Device

MIDT muszic plavback.

% Default device:

[reeti I Micrazoft G5 Wavetable SW Synth w !

[ Wolume. . ] [ About... ]

[ Use only default devices

I Ok H Cancel H Apply ]

5. Click the Volume button under the Sound recording tab to open "Recording
Control® interface;

6. Adjust the line in volume to a level without distortion. You can play a record on the
turntable and use the Sound Recorder to record a short clip of music for testing. The
sound wave will show on the interface screen when recording.

Audio Properties

ie. 00K

Audio Devices | -
Cptions  Help
Sound playback
@ Default device: Micrnphnne
4 i C-Media'Wave Device v |
[ Wolume... ] [ Advanced... ] Balance:
Sound recording @ @
/@ D efault device:
|USB PnP Audio Device v Walume:
[ volume. .. | [ Advanced... ‘
MIDT muszic playback
% D efault device:
[Pt I Microzoft GS “Wawvetable 5% Synth w !
[ Yolume. . ] [ About... ] I:l H e
ute
[ Use only default devices
IUSE Audio Controller
[ ak ] [ Cancel ] [ Apply ]

RUNNING AUDACITY SOFTWARE

Note: Please review the software license and distribution restrictions found on the
software disc. Use of the Audacity software is subject to those conditions and restriction.
For additional help with recording and editing music by using the Audacity software,
please visit http://audacity.sourceforge.net/
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1. Run the Audacity from the Windows start menu or double click the Audacity icon on
your computer desktop.

2. The Audacity main screen appears. You will find the Record, Play, Pause, Stop, Skip
to Start and Skip to End control buttons here. Use the File, Edit, View, Transport,
Tracks, Generate, Effect and Analyze menus from your computer screen to Save,
Export or Edit the music.

Tinspat Tads Gener

rate Effect Anslyze Help.
= . o[ slolalalipfio
DO®e oL =

130 10 150 160 170

3. Click “Preferences” at the bottom of the Edit menu, you can set the Devices, Quality,
and various settings here.

File Visw Transport Tracks Generats Effect Analyze Hslp

Unda iz E = EI TLT M g + e Ia|§| |‘|
Redo i o) =7 E [ I ] I = i # i OE# &
R \ : p|-—- |- 4w # 0 S 2 0| e | 4 | CVedawave Device | ¥ C-Media wave Device: &
Clp Boundaries v 20 30 40 50 6.0 70 80 90 100 110
Copy Cirl+c

Paste ctri+y

Paste Text ta New Label  Chrl+Al+Y

Duplicate oD
Lebeled Regions »
Select »
Find Zero Crossings 2

Move Cursor »
Region Save

Region Restore

Flay Region 3




Preferences: Devices

- Devices

- Playback

- Recording

- Cualiby

- Interface

-~ Tracks

- Import | Export
- Extended Impart
- Projects
~Libraries

- Spectrograms
- Direckaries

- Warnings

- Effects

- Kevboard

- Mause

4. Adjust the input and output volume by sliding the Input and Output Volume bars.

Inkerface

Host: |MME v|

Using: Partaudio ¥19-devel (builk Feb 4 2012 23:27:31)

Plavback.

Device: |C—Media Wave Device b |

Recording

SR [USB PrP Audio Device [+]

Channels: |2 (Steren)

]

Output Volume Input Volume
[ [l \\ = I/
= = + - +
Il- = 1?} 1 If'—,..-l Lo |ﬁ [ 'E.-I' ] ol
IR L

5. Click the record button to start recording, left and right tracks will show on your
computer screen. If you cannot see the sound waves appear on the Interface when
recording, adjust the Input volume bar.

e
He ft Yew Tenport Tiads Generste G dndyee m
E _ I T T
T e y et [ e T TIPS
I IND J J P‘ ‘ Y e ) [Ctedia wave Deviee | /9]0 audo Controler 2 (teren) g
10 q 50 60 70 80 20 100 110 120 130 140 150 160 70
X dudio Track ¥| 1.0
Stereo, 44100z
32-bt float 05
e | Sob
. + | 0o
gt
L ® |05
Lot
10
10
0.5
0.0-|
-05
ST
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6. Use the Audacity control panel to record or listen the music you have recorded
- Click ® button to start recording.

- Click the << button to skip to start;

- Click the > button to skip to end;

- Click the > button to play;

- Click the “ button to pause;
- Click the O button to stop.

. W) ) m) M) ) @

EXPORT THE MUSIC FILES TO WAV OR MP3 FORMAT

Once you have finished recording, make sure you save your recorded music to the

computer.

1. Click File menu and move down to “Export” to convert the file to WAV format or MP3
format.

2. Click on WAV or MP3 format you want to save the music as in pull down menu of
“Save as type” field, and you will be asked for the file name of your recorded music
NOTE: Audacity does not export MP3 files directly. If you want to encode your recorded
music to MP3 format, you need to download the LAME MP3 encoder either in the CD

provided or under the page “Other Audacity Downloads for Windows” of the website
http://audacity.sourceforge.net/

INSTALL THE MP3 ENCODER
1. Insert the included CD into your computer and select “Audacity 2.0(Windows
2000, XP, Vista, 7, 8)” under “Windows” folder.

2. Open the folder and select “Plug-ins”.

3. Double click the “Lame_v3.99.3_for_windows.exe” file under “Plug-ins” folder to

start install the program.

Note: Normally, Audacity will automatically locate the Lame file that you installed.
However, if you change default directory of Lame program, you may need to
manually locate it by using Audacity-> Edit-> Preference->Libraries and the
click “Locate” button on computer screen to browse “lame_enc.dll” file where
the directory you have installed. See Fig.1 & 2 below and click OK to finish
manual installation.
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Preferences: Libraries

X)

Devices MP3 Export Library
Playback MP3 Library Yersion: MP3 export library nok found
Eeording MP3 Library: [
Cuality
Interfacs LAME MP3 Library:
Tracks
Import | Export FFmpeq Import/Export Library
Extended Import FFmpeq Library Yersion: FRmpeq library nok found
T mpeq Library: ocate...
Spectrograms FFmpeq Library:
Directories
Warnings
Effects
Kevboard
Mouse
Ok ] [ Cancel

Fig. 1

X

Locate Lame

Budarity needs the file lame_enc.dll to create MP3s,

Location of lame_enc.dll;

Browse, .,

To get a free copy of Lame, click here --= | Download

[ Ok H Cancel ]

Fig.2

CARE AND MAINTENANCE

1. Avoid operating your unit under direct sunlight or in hot, humid or dusty places.

2. Keep your unit away from heating appliances and sources of electrical noise such as
fluorescent lamps or motors.

3. Unplug the unit from the electrical power outlet immediately in case of malfunction.

CLEANING THE UNIT

® To prevent fire or shock hazard, disconnect your unit from the AC power source
when cleaning.

® The finish on the unit may be cleaned with a dust cloth and cared for as other
furniture, Use caution when cleaning and wiping the plastic parts.

® |[f the cabinet becomes dusty wipe it with a soft dry dust cloth. Do not use any wax or
polish sprays on the cabinet.

® |f the front panel becomes dirty or smudged with fingerprints it may be cleaned with a
soft cloth slightly dampened with a mild soap and water solution. Never use abrasive
cloths or polishes as these will damage the finish of your unit.

CAUTION: Never allow any water or other liquids to get inside the unit while cleaning.

E-13



TROUBLESHOOTING GUIDE

SHOULD YOU EXPERIENCE DIFFICULTIES IN THE USE OF THIS PLAYER PLEASE REFER TO THE
FOLLOWING CHART OR CALL 1-800-777-5331 FOR CUSTOMER SERVICE.

PROBLEM POSSIBLE CAUSE SOLUTION

AC power cord is not plugged into a .
. Plug the AC power cord into a wall
wall outlet or the connector is not )
i ] outlet and plug the connector into the
plugged into the power supply jack

. supply jack on the unit.
The unit does on the back of the unit. PR

not respond (no

power). . L Plug another device into the same

Wall outlet is not functioning. outlet to confirm the outlet is working.
o " Slide the POWER ON/OFF switch to
POWER Switch in the OFF position N
the ON position
Unit is ON but .
) The volume Control has been Turn the Volume control to a higher

there is low or
turned all the way down output

no volume

Sound is . .

distorted. Volume level is set too high Decrease the volume

SPECIFICATION

AC Power AC 120V ~ 60Hz 8 Watts
Batteries UM2 X 8 pcs for battery operation

System Requirement: Windows 2000 / XP/ Vista/7 /8

Mac OS X 10.4 - 10.7.5

SPECTRA GREEN NOTICE

At Spectra, environmental and social responsibility is a core

\ S P E C TRA® value of our business. We are dedicated to continuous

implementation of responsible initiatives with an aim to
.7 green

conserve and maintain the environment through responsible
recycling.
Please visit us at http://www.spectraintl.com/green.htm for more information on Spectra’s green
initiatives or to find a recycler in your area.




90 DAY LIMITED WARRANTY AND SERVICE

VALID IN THE U.S.A ONLY

SPECTRA MERCHANDISING INTERNATIONAL, INC. warrants this unit to be free from
defective materials or factory workmanship for a period of 90 days from the date of original
customer purchase and provided the product is utilized within the U.S.A. This warranty is not
assignable or transferable. Our obligation under this warranty is the repair or replacement of
the defective unit or any part thereof, except batteries, when it is returned to the SPECTRA
Service Department, accompanied by proof of the date of original consumer purchase, such as a
duplicate copy of a sales receipt.

You must pay all shipping charges required to ship the product to SPECTRA for warranty service.
If the product is repaired or replaced under warranty, the return charges will be at SPECTRA’s
expense. There are no other express warranties other than those stated herein.

This warranty is valid only in accordance with the conditions set forth below:

1. The warranty applies to the SPECTRA product only while:

a. It remains in the possession of the original purchaser and proof of purchase is
demonstrated.

b. It has not been subjected to accident, misuse, abuse, improper service, usage outside
the descriptions and warnings covered within the user manual or non-SPECTRA
approved modifications.

c. Claims are made within the warranty period.

2. This warranty does not cover damage or equipment failure caused by electrical wiring not in
compliance with electrical codes or SPECTRA user manual specifications, or failure to
provide reasonable care and necessary maintenance as outlined in the user manual.

3. Warranty of all SPECTRA products applies to residential use only and is void when products
are used in a nonresidential environment or installed outside the United States.

This warranty gives you specific legal rights, and you may also have other rights which vary from
state to state. TO OBTAIN SERVICE please remove all batteries (if any) and pack the unit
carefully and send it freight prepaid to SPECTRA at the address shown below. IF THE UNIT IS
RETURNED WITHIN THE WARRANTY PERIOD shown above, please include a proof of
purchase (dated cash register receipt) so that we may establish your eligibility for warranty
service and repair of the unit without cost. Also include a note with a description explaining how
the unit is defective. A customer service representative may need to contact you regarding the
status of your repair, so please include your name, address, phone number and email address to
expedite the process.

IF THE UNIT IS OUTSIDE THE WARRANTY PERIOD, please include a check for $50.00 to
cover the cost of repair, handling and return postage. All out of warranty returns must be sent
prepaid.

It is recommended that you contact SPECTRA first at 1-800-777-5331 or by email at
custserv@spectraintl.com for updated information on the unit requiring service. In some cases
the model you have may be discontinued, and SPECTRA reserves the right to offer alternative
options for repair or replacement.

SPECTRA MERCHANDISING INTERNATIONAL, INC.

4230 North Normandy Avenue,

Chicago, 1L60634, USA. 1-800-777-5331

To register your product, visit the link on the website below to enter your information.
http://www.spectraintl.com/wform.htm
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